
Experiment VP-1: Blood Pressure, Pulse, and Body Position

Background

When the heart pumps blood into the arteries, there is a sudden increase in pressure in the arteries. The 
highest level of pressure, that occurs immediately after the ventricles contract, is known as the systolic 
blood pressure. The pressure in the arteries slowly declines as the heart relaxes. The lowest level of 
pressure, that occurs just prior to the next contraction of the ventricles, is known as the diastolic blood 
pressure.

Systolic and diastolic blood pressures are commonly measured with a stethoscope and a 
sphygmomanometer (blood pressure cuff). The cuff is placed on the upper left arm as the stethoscope is
used to listen to the pulsatile flow of blood in the major artery of the arm. Once the stethoscope is 
properly placed over the artery and the thumping sound of the pulse is heard, the cuff is inflated. If the 
pressure in the cuff is high enough, the cuff compresses the artery in the upper arm and the flow of 
blood through the artery to the lower arm stops and the thumping sound disappears. When the pressure 
in the cuff is released and the pressure in the artery is greater than the pressure in the cuff, blood 
resumes flowing to the lower arm. As the blood resumes flowing into the lower arm, the thumping 
sound of the pulse reappears. The pressure in the blood pressure cuff at the time that the thumping 
sound first reappears is equal to the systolic blood pressure. When more pressure is released from the 
cuff, the thumping sound eventually disappears, again. The pressure in the blood pressure cuff at the 
time that the thumping sound disappears is equal to the diastolic blood pressure. 

Measuring blood pressure using a blood pressure cuff and a stethoscope takes a great deal of practice. 
To assist students in learning the technique of taking blood pressures with a stethoscope, a pulse 
plethysmograph will be used to record the appearance and disappearance of pulsatile blood flow in the 
artery that indicate when the pressures in the cuff are equal to the systolic and diastolic blood pressures.
In addition to learning to measure the blood pressure and comparing blood pressures from different 
subjects, the effects of cuff location, body position, and arm position will be examined. 

Warning: As explained above, this procedure involves stopping blood flow to the arm, which 
is potentially dangerous. Please take the following precautions. 

Precautions

1. Know what you are doing ahead of time.

2. Do not leave the cuff inflated for any prolonged period of time (>20 seconds).

3. The subject should flex and extend their fingers between experiments to maintain blood flow.

4. This experiment should be performed by healthy individuals who do not have a personal or 
family history of cardiovascular or respiratory problems. It is preferable to use more than one 
subject during the course of the lab session.
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Equipment Required

PC or Mac Computer

IX-ELVIS

USB cable

Power supply

PTN-104 Pulse plethysmograph

Stethoscope

BP-220 Non-invasive blood pressure transducer

GPSN-100 gas pressure sensor 

A-BT-100 tubing

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the BP-Pulse-BodyPosition-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the BP-
Pulse-BodyPosition-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Blood Pressure and Pulse Transducers Setup

1. Locate the BP-220 non-invasive blood pressure (NIBP) transducer,  the A-BT-100 tubing, and 
the GPSN Pressure sensor. Assemble as illustrated in Figure VP-1-S1.
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2. Locate the PTN-104 pulse transducer (Figure VP-1-S2)

Figure VP-1-S1: The BP-220 non-invasive blood pressure transducer.

2. Plug the mini-DIN connector of the PTN-104 into the Channel 3 input of the IX-ELVIS (Figure 
VP-1-S3).

3. Plug the mini-DIN connector of the GPSN-100 into the Channel 4 input of the IX-ELVIS 
(Figure VP-1-S3). 

Figure VP-1-S2: The PTN-104 pulse plethysmograph.
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Figure VP-1-S3: The PTN-104 pulse transducer and the BP-220 non-invasive blood pressure 
transducer connected to the IX-ELVIS.

Calibration of the Non-Invasive Blood Pressure Transducer

Procedure

1. With the supplied manometer in place, put the cuff of the BP-220 on the upper arm of the 
subject. Align the arrow on the cuff over the subject’s brachial artery. Have the subject rest in 
the supine position while the blood pressure sensor is calibrated.

2. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure VP-1-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the IX-ELVIS 
and computer, an error window will appear in the center of the Main window. Make sure the 
IX-ELVIS is turned on and connected to the USB port of the computer. Click OK and select the 
Find Hardware function from the LabScribe Tools menu. 

3. Type “Calibration @ 70 mmHg” in the Mark box to the right of the Mark button. Inflate the 
pressure in the cuff to 70 mmHg as read on the manometer. 

4. Click on the AutoScale button at the upper margin of the Pulse and Blood Pressure channels. 
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Your recording should look like Figure VP-1-L1. 

• If the signal on the Pulse channel is upside down when compared to trace in Figure VP-1-L1,
click on the downward arrow to the left of the channel title and select the Invert function. 
The trace should now look similar to the one in the figure.

• If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse 
plethysmograph to the finger.

5. While recording, press the Enter key on the keyboard to mark the pressure in the cuff on the 
data. Record the output of the BP-220 at 70 mmHg pressure for ten to fifteen seconds before 
increasing the pressure in the cuff (Figure VP-1-L1). While recording at a pressure of 70 
mmHg, type “Calibration @ 140 mmHg” in the Mark box.

6. As the recording continues, increase the pressure in the cuff to 140 mmHg and press the Enter 
key on the keyboard. Hold the pressure in the cuff at this level for ten to fifteen seconds. Then, 
click the Stop button to halt the recording.

7. After the last measurement, use the blue valve to release all the pressure from the blood 
pressure cuff and remove the manometer. The subject should continue to relax in the supine 
position as he or she flexes and extends the fingers on the cuffed arm to return of blood to the 
arm. You can remove the BP-220 cuff from the subject until Exercise 3.

8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file.

Units Conversion

1. Scroll to the beginning of the calibration data for the BP-220 non-invasive blood pressure 
transducer.

2. Use the Display Time icons to adjust the Display Time of the Main window to show the data 
collected at 70 and 140 mmHg on the Main window at the same time (Figure VP-1-L1). The 
required data can also be selected by:

• Placing the cursors on either side of data required

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
with the four selected pulse cycles to the width of the Main window.

3. Click the 2-Cursor icon (Figure VP-1-L2) so that two vertical cursors appear on the Main 
window. Place one cursor on the flat section of data collected when the pressure in the cuff was 
70 mmHg and the second cursor on the flat section of data collected when the pressure was 140 
mmHg.
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Figure VP-1-L1: The output of the BP-220 non-invasive blood pressure transducer displayed on the 
Main window with cursors at the points where the pressures in the cuff were 70 and 140 mmHg.

Figure VP-1-L2: The LabScribe toolbar.

4. To convert the voltages at the positions of the cursors to pressure values, use the Simple Units 
Conversion dialogue window (Figure VP-1-L3). To access this dialogue window, click on the 
arrow to the left of the channel title, Blood Pressure, to open the channel menu. Select Units 
from the channel menu, and select Simple from the Units submenu. 

5. On the units conversion window, make sure 2 point calibration is selected in the pull-down 
menu in the upper-left corner of the window. Put a check mark in the box next to Apply units to 
all blocks. Notice that the voltages from the positions of the cursors are automatically entered 
into the value equations. Enter the two pressures used in the calibration recording in the 
corresponding boxes on the right side of the conversion equations. Enter the name of the units, 
mmHg, in box below the pressures. Click on the OK button in the lower right corner of the 
window to activate the units conversion.
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Figure VP-1-L3: The Simple Units Conversion dialogue window with the voltages at the cursors set to 
equal the pressures used in calibration.

Exercise 1: Blood Pressures from the Left Arm

Aim: To determine the systolic and diastolic blood pressures in a reclining subject, and if the 
subject is hypotensive (low blood pressure), normotensive, or hypertensive (high blood 
pressure).

Procedure

1. Instruct the subject to rest in the supine position for at least five minutes before his or her blood 
pressure is taken.

2. While the subject is resting, place the blood pressure cuff of the BP-220 around the upper 
portion of the left arm, just above the elbow. Place the PTN-104 pulse plethysmograph on the 
volar surface (where the fingerprints are located) of the distal segment of the left middle finger 
or thumb. Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.

3. At the end of the rest period, click on the Record button to begin recording the subject’s pulse 
and the blood pressure.

4. Inflate the blood pressure cuff until the finger pulse wave on the Pulse channel disappears 
(Figure VP-1-L4).

5. Once the pulse wave disappears, use the blue valve to release the cuff pressure at the rate of ~10
mmHg/second. Continue to release the pressure in the cuff until the aneuroid gauge reads 20 
mmHg. 

6. Click the Stop button. Make sure the blood pressure cuff is completely deflated and is not 
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putting any unnecessary pressure on the subject's arm.

7. The subject should continue to rest in the supine position between Exercises 1 and 2. To 
improve circulation in his or her arm, the subject should flex and extend their fingers to 
encourage blood circulation. 

8. Select Save in the File menu.

Figure VP-1-L4: The pulse wave and the pressure in the cuff of the BP-220 recorded before, during, 
and after the occlusion of the brachial artery. Pulses disappeared as the pressure in the cuff exceeded 
the pressure in the artery. As the pressure in the cuff is released, the pulse wave reappears.

Data Analysis

1. Scroll through the recording and find the section of data recorded before, during, and after the 
pressure in the cuff was occluding the pulse (Figure VP-1-L4). 

2. Use the Display Time icons to adjust the Display Time of the Main window to show the pulse 
and the pressure in the cuff of the BP-220 from the occlusion of the artery to the pressure in the 
cuff being 20 mmHg. This section of data can also be selected by:

• Placing the cursors on either side of the section of data needed, and;

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
of data to the width of the Main window.

3. Click on the Analysis window icon in the toolbar (Figure VP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window.
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4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The mathematical functions that are listed should include V2-V1, Value1, Value2, and 
T2-T1. The values for these parameters from each channel are seen in the table across the top 
margin of each channel.

5. Once the cursors are placed in the correct positions for determining the blood pressures, the 
values for the blood pressures can be recorded in the on-line notebook of LabScribe by typing 
the names and values directly into the Journal.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the cuff pressures from the Blood 
Pressure channel.

• Transfer the name of the mathematical function used to determine the blood pressure to the 
Journal using the Add Title to Journal function in the ECG Channel pull-down menu.

• Transfer the value for the blood pressure to the Journal using the Add Ch. Data to Journal 
function in the ECG Channel pull-down menu.

7. Once the cursors are placed in the correct positions for determining the systolic, diastolic, and 
pulse pressures, record the values for these pressures in the Journal using the one of the 
techniques described in Steps 5 or 6.

8. Use the mouse to click on and drag the cursors to specific points on the pulse and blood 
pressure recording to measure the following:

• Systolic blood pressure. Place a cursor on the first of the smallest pulse waves that reappear 
after the pressure from the cuff of the BP-220 is released. Value1 on the Blood Pressure 
channel is the systolic blood pressure. Enter this pressure in Table VP-1-L2.

• Diastolic blood pressure. Place the other cursor on the first of the largest pulse waves that 
reappear as the pressure from the cuff of the BP-220 is released. Value2 on the Blood 
Pressure channel is the diastolic blood pressure. Enter this pressure in Table VP-1-L2.

• Pulse pressure, which is the difference between the systolic and diastolic pressures. To 
measure the pulse pressure, leave the cursors on the pulses that occur at the systolic and 
diastolic pressures. The value for V2-V1 on the Blood Pressure channel is the pulse 
pressure. Enter this pressure in Table VP-1-L2.

9. Determine the subject’s blood pressure class from Table VP-1-L1. List it in Table VP-1-L2.
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Table VP-1-L1: Classification of Blood Pressure Levels According to the 7th Report of the Joint 
National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood Pressure
(JNC 7).

Class Systolic Pressure (mmHg) Diastolic Pressure (mmHg)

Hypotensive  less than 90 less than 60

Normal 120  and 60-80

Prehypertensive 120-139 or 80-89

Hypertensive Stage 1 140-159 or 90-99

Hypertensive Stage 2 greater than 60 or greater than 100

Table VP-1-L2: Blood Pressures from Different Arms in Different Positions

Subject_______

Systolic Pressure
(mmHg)

Diastolic Pressure 
(mmHg)

Pulse Pressure 
(mmHg)

BP ClassCuff 
Location/Hand 
Position

Upper Left
Arm/Hand Low,

Ex.1

Upper Left
Arm/Hand Low,

Ex.2

Upper Right
Arm/Hand Low

Lower Right
Arm/Hand Low

Left Arm/Left
Hand Low

Left Arm/Right
Hand High

Left Arm/Left
Hand High
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Exercise 2: Repeatability of Blood Pressure Measurements

Aim: To determine the repeatability of the blood pressure measurement.from the upper left arm 
of the same subject.

Procedure

1. Repeat the procedures outlined in Exercise 1 on the same subject.

2. The subject should continue to rest in the supine position between Exercises 2 and 3.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures of 
the subject.

Questions

1. Are the systolic and diastolic blood pressures from Exercises 1 and 2 identical? What are the 
possible sources of variation?

2. Since the pressures are determined using changes in the pulse amplitude, would slowing the rate
at which pressure is released from the cuff make your readings more accurate? 

Warning: If you decide to slow the release from the cuff pressure, remember that restricting 
circulation for a prolonged period can be dangerous. Do not release the pressure in the cuff 
at a rate any slower than 5 mm Hg per second.

 

Exercise 3: Blood Pressures from the Right Arm

Aim: To measure blood pressure from the right arm.

Procedure

1. The subject should continue to rest in the supine position before and during this exercise.

2. Place the blood pressure cuff of the BP-220 around the upper portion of the right arm, just 
above the elbow. Place the PTN-104 pulse plethysmograph on the volar surface of the distal 
segment of the right middle finger or thumb. Wrap the Velcro strap around the end of the finger 
to attach the unit firmly in place.

3. Use the same procedures outlined in Exercise 1 to record the subject’s blood pressures from his 
or her upper right arm.

4. The subject should continue to rest in the supine position between Exercises 3 and 4.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures 
recorded from the upper right arm of the subject.
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Question

Are the values the same as those obtained for the left arm? Explain any differences.

Exercise 4: Blood Pressures from the Forearm

Aim: To examine whether blood pressure declines with distance from the heart.

Procedure

1. The subject should continue to rest in the supine position before and during this exercise.

2. Move the blood pressure cuff from the upper right arm to the lower right arm.

3. Use the same procedures enumerated in Exercise 1 to record the subject’s blood pressures from 
his or her lower right arm.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures 
recorded from the lower right arm of the subject.

Question

Are the values from the forearm the same as those obtained with the cuff on the upper arm? Explain 
any variations that you see.

Exercise 5: Blood Pressures with Different Arm Positions

Aim: To examine the effects of gravity on blood pressure and peripheral circulation.

Procedure

1. Select a new subject and instruct the subject to sit and relax for at least five minutes before his 
or her blood pressure is taken.

2. While the subject is relaxing, place the blood pressure cuff of the BP-220 around the upper 
portion of the left arm, just above the elbow and the PTN-104 on the volar surface of the distal 
segment of the left middle finger. Wrap the Velcro strap around the end of the finger to attach 
the unit firmly in place.

3. At the end of the relaxation period, use the same procedures used in Exercise 1 to determine the
blood pressures of the subject while the subject is resting both hands in his or her lap.

4. Instruct the subject to place his or her right hand on top of their head. Determine the blood 
pressures of the subject while his or her right hand in this position. Instruct the subject to return 
his or her hand to their lap after the blood pressures in this position are determined.

5. Instruct the subject to place his or her left hand on top of their head. Determine the blood 
pressures of the subject while his or her left hand in this position. Instruct the subject to return 
his or her hand to their lap after the blood pressures in this position are determined.

6. Select Save in the File menu.
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7. The subject should continue to sit and relax between Exercises 5 and 6.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures 
recorded from the upper left arm of the subject.

Question

What is the effect of raising each hand on the blood pressure in the left arm? Explain your results.

Exercise 6: Blood Pressures from the Leg

Aim: To measure blood pressures from the leg.

Procedure

1. Instruct the subject used in Exercise 5 to sit and relax before his or her blood pressure is taken.

2. While the subject is relaxing, place the blood pressure cuff of the BP-220 around the lower left 
leg, just above the ankle, and the PTN-104 on the volar surface of the distal segment of the left 
large toe. Wrap the Velcro strap around the end of the toe to attach the unit firmly in place.

3. At the end of the relaxation period, use the same procedures used in Exercise 1 to determine the
blood pressures in the subject’s left leg while he or she is sitting with the left foot on the floor.

4. Determine the blood pressures in the subject’s left leg when he or she is:

• reclining in the supine position.

• lifting his or her left leg perpendicular to the bench while reclining; support the leg with a 
chair.

• standing.

• standing for three minutes.

5. Select Save in the File menu.

Data Analysis

Use the same techniques used in Exercise 1 to determine the systolic and diastolic blood pressures 
recorded from the left leg of the subject. Record all data in Table VP-1-L3. 

Questions

1. Are the blood pressure values from the leg the same as those obtained from the arms? Explain 
any differences.

2. What happens to the blood pressures in the subject’s left leg when the subject reclines? When 
the subject lifts his or her left leg perpendicular to the bench? When the subject stands? After 

Vascular Physiology-BP-Pulse-BodyPosition VP-1-13

file:///Users/stephenhauptman/Desktop/IFHPLMv2/BP-Pulse-BodyPosition-F-LS2.htm#Rah67947


the subject has been standing for three minutes?

3. What is happening physiologically to cause the changes discussed in Question 2?

Table VP-1-L3: Blood Pressures from the Left Leg in Different Positions

Subject_______ Systolic
Pressure 
(mmHg)

Diastolic Pressure 
(mmHg)

Pulse Pressure 
(mmHg)

BP Class
Leg Position

Sitting

Reclining

Leg Vertical

Standing

Standing 3 Mins
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